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RESUMO 

Hoje em dia a grande concorrência que existe entre empresas e a facilidade de escrutínio pelo público 

em geral tornam a tomada de decisão uma área crítica quer para empresas como para entidades 

públicas. A escolha entre várias alternativas possíveis é um problema que surge diariamente nos vários 

sectores de atividade, e torna-se necessária a criação de ferramentas que auxiliem esta tomada de 

decisão. 

Esta tese de mestrado tem como objetivo fazer uma atualização do estado da arte no que diz respeito a 

técnicas de decisão multicritério, bem como a ferramentas informáticas que implementem essas 

técnicas. Com base nesta revisão, foi possível melhorar uma ferramenta de apoio à decisão, o 

BeSmart, um software de utilização intuitiva que permite auxiliar o processo de decisão em problemas 

multicritério. 
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ABSTRACT 

 

In today’s world, due to the big competition between companies and the ease of access to information 

by the public, decision making is a critical area for both firms and public entities. Choosing between 

various possible alternatives is a problem that comes up daily in a lot of activity sectors, and it becomes 

necessary the development of tool to aid decision making. 

The objective of this master’s thesis is to make an updated revision of the state of the art in multicriteria 

decision techniques and in informatics tools that implement these techniques. Based on this study, it 

was possible to improve a decision support tool, BeSmart, a software of intuitive utilization that aids the 

decision making process in multicriteria problems. 

 KEYWORDS 

Multicriteria Decision Analysis, Decision Support System, AHP, SMART, Value Functions 
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1. INTRODUÇÃO 

1.1 Contextualização e Enquadramento 

A decisão tem inspirado reflexão por parte de muitos filósofos e intelectuais desde a antiguidade. É 

muitas vezes sugerido que a capacidade humana para a decisão é aquilo que nos distingue dos 

restantes animais. Com a evolução dos tempos, evoluiu também a necessidade de tomar uma maior 

quantidade de decisões de cada vez. Tendo em conta a concorrência que existe entre as empresas, 

cada decisão, por mais simples que pareça, pode resultar numa vantagem, que pode fazer a diferença 

em relação aos outros concorrentes. 

A capacidade de tomar estas decisões é uma qualidade fundamental, mas os problemas de decisão 

são cada vez mais complexos e em grande volume. Como todos já pudemos constatar em certas 

ocasiões, tomar a melhor decisão pode ser uma tarefa bastante difícil, seja devido à incerteza, ao longo 

do período de tempo sobre o qual terá efeito, às decisões tomadas pelos vários concorrentes ou 

simplesmente à sua grande complexidade. 

“A tomada de decisão é um esforço para tentar resolver problemas com objetivos conflituantes, cuja 

presença impede a existência da solução ótima e conduz à procura do melhor compromisso” (Zeleny & 

Cochrane, 1982). Tomar uma decisão irá resultar em investimentos de tempo e dinheiro, que por 

vezes não serão recuperáveis. Um dos maiores erros cometidos pelos decisores é a tendência a “fazer 

escolhas de modo a justificar decisões anteriores, ainda que estas já não pareçam mais válidas” 

(Hammond et al., 1999). É importante lembrar que as influências das decisões irão recair sobre o 

futuro, e não sobre o passado. 

Torna-se então importante garantir que as decisões tomadas são racionais e não são resultados de 

preconceitos naturais da mente, tal como a sua tendência a dar mais relevância à primeira informação 

que se recebe (Hammond et al., 1999). A teoria da decisão surgiu então como o estudo do processo 

de tomada de decisão, e deu origem a vários métodos de apoio à decisão, nomeadamente os métodos 

de Análise de Decisão Multicritério (ADM). 

Devido ao volume cada vez maior de informação envolvida no processo de tomada de decisão, propõe-

se a realização de um projeto de investigação relacionado com a ADM, que resulte na obtenção de 

uma ferramenta informática que implemente uma variedade de métodos e que permita o seu acesso 

ao utilizador comum.  
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1.2 Motivações e Objetivos 

A tomada de decisão é um processo que por vezes se torna complexo sem a ajuda de ferramentas 

informáticas. Nesse sentido, este trabalho têm como objetivo a melhoria de um software que permite a 

resolução de problemas de decisão por indivíduos e empresas. O tema de investigação desta tese de 

mestrado foi sugerido pela professora Anabela Tereso, docente do Departamento de Produção e 

Sistemas da Universidade do Minho. 

O projeto iniciou com uma pesquisa bibliográfica, em que se realizou um levantamento das principais 

técnicas e ferramentas para a análise de decisão multicritério. O objetivo desta fase foi perceber a 

teoria da decisão e comparar as principais técnicas e métodos, bem como perceber o que está 

implementado nas ferramentas atuais de decisão multicritério. 

Depois de feito este levantamento, procedeu-se à implementação de melhorias num software de 

análise de decisão genérico, que permite a aplicação dos métodos e técnicas estudadas anteriormente 

na resolução de problemas de decisão. Por fim, foi feito um teste desta ferramenta e uma discussão 

dos resultados obtidos. 

Tendo isto em conta, os objetivos do projeto foram: 

 Atualização do estado da arte relativamente aos métodos e ferramentas de apoio à decisão 

multicritério. 

 Criação de uma ferramenta informática com base em ferramentas criadas anteriormente e que 

permita a aplicação de métodos de decisão multicritério em problemas genéricos. 

 Teste do software criado e discussão dos resultados obtidos. 

1.3 Metodologia Utilizada 

Neste projeto utilizou-se a metodologia de investigação documental e experimentação (Saunders et al., 

2011). A investigação será desenvolvida numa abordagem dedutiva, ou seja, a ferramenta a ser 

construída será relacionada com a literatura revista: o software a desenvolver irá aplicar os métodos 

analisados no levantamento efetuado na área da decisão multicritério. 

A pesquisa bibliográfica iniciou-se com a leitura da sebenta de Técnicas de Decisão Multicritério da 

Doutora Anabela Tereso (Tereso, 2009), para obter uma primeira abordagem ao tema da teoria da 

decisão e à decisão multicritério, e da dissertação de Mestrado da Mestre Cristina Seixedo (Seixedo, 

2009), para ter um ponto de partida para uma atualização do estado da arte das ferramentas de 

software de decisão multicritério. 
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Seguidamente, recorreu-se a várias fontes diferentes para obter mais literatura relacionada com o 

tema: 

 Fontes terciárias através da pesquisa na internet, nomeadamente nos seguintes motores de 

busca: 

o Google Académico (http://scholar.google.com). 

o Repositório da UM (http://repositorium.sdum.uminho.pt). 

o Driver (http://www.driver-community.eu). 

o Elsevier (http://www.elsevier.com). 

o Wiley InterScience (http://www.interscience.wiley.com). 

o ScienceDirect (http://www.sciencedirect.com). 

 Fontes secundárias da biblioteca da Universidade do Minho. 

 Obtenção de literatura importante referenciada em livros e artigos de revistas científicas 

entretanto lidos. 

No desenvolvimento da ferramenta de software, foi tomado como base a ferramenta BeSmart (Tereso 

et al., 2011) e foram melhoradas as suas características, tendo em conta as técnicas e ferramentas de 

software mais atuais, descobertos durante a pesquisa bibliográfica. 

1.4 Organização do Relatório 

Este relatório está dividido em seis capítulo, que serão descritos em seguida. 

No primeiro capítulo é feita uma introdução, contextualização e enquadramento do tema da 

dissertação, são apresentados os objetivos de investigação, a metodologia e a estrutura do relatório. 

No segundo capítulo é feita uma introdução à teoria de decisão, explicando qual é o seu papel. É 

também feita uma análise do paradigma de decisão e são apresentados os vários problemas e 

conceitos base relacionados. 

No terceiro capítulo é apresentada uma revisão sobre a teoria da decisão multicritério, explicando 

como é feita a modelação das preferências, são apresentados vários métodos de análise de decisão 

multicritério bem como alguns pacotes de software criados com base nesses métodos. 

No quarto capítulo é apresentado o processo de desenvolvimento da ferramenta informática, desde a 

linguagem de programação utilizada até aos elementos principais e cálculos efetuados pela ferramenta. 

No quinto capítulo mostra-se um exemplo prático de utilização da ferramenta, incluindo a sua 

instalação, criação de um novo modelo e realização de cálculos e comparações. 

http://scholar.google.com/
http://repositorium.sdum.uminho.pt/
http://www.driver-community.eu/
http://www.elsevier.com/
http://www.interscience.wiley.com/
http://www.sciencedirect.com/
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No último capítulo são retiradas conclusões do trabalho realizado e apresentam-se propostas para 

trabalho futuro. 
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2. TEORIA DE DECISÃO 

Neste capítulo será feita uma introdução à teoria de decisão que servirá como base para o capítulo 

seguinte sobre Análise de Decisão Multicritério. 

2.1 Introdução à teoria de decisão 

Quando estamos perante um problema que possui mais do que uma alternativa de solução estamos 

perante um problema de decisão. Para ilustrar alguns aspetos importantes da decisão, podemos 

recorrer a duas passagens de intelectuais da antiguidade. Esta primeira passagem faz parte de 

“Exercícios Espirituais” de S. Inácio de Loyola (Loyola, 1964, p. 90). 

 

“Para considerar quantas vantagens e utilidades trará para mim a ocupação do cargo ou benefício (…) 

e, considerar da mesma forma, pelo contrário, as desvantagens e perigos que surgem no mesmo. 

Fazer o mesmo na segunda parte, isto é, olhar para as vantagens e utilidades de não ocupar o cargo, e 

pelo contrário, as desvantagens e perigos de não o ter.[…] Após discussão e ponderação de ambos os 

lados da proposta, devo olhar para onde a razão se inclina: e então, de acordo com a maior inclinação 

da razão, […] deve ser feita uma deliberação.” 

 

A segunda passagem surge numa carta escrita por Benjamin Franklin (MacCrimmon, 1973, p. 18). 

 

“Neste assunto de muita importância para si em que pede o meu conselho, eu não posso, por falta de 

premissas suficientes, aconselhar qual a sua decisão, mas posso dizer como a tomar. […], o meu 

método é dividir meia folha de papel com uma linha em duas colunas; escrevendo no topo de uma 

Prós, e na outra Contras. […] Quando estiverem todas preenchidas, eu tento estimar os respetivos 

pesos; onde eu encontro duas, uma em cada lado, que pareçam iguais, eu risco as duas. Se encontrar 

uma razão pró igual a duas razões contra, eu corto as três. Se julgar duas razões contra iguais a três 

razões pro, eu corto as cinco; e assim procedendo até descobrir onde pesa mais a balança; e se, após 

um ou dois dias de consideração, nada de novo de importância surja em nenhum dos lados, eu tomo a 

decisão de acordo.” 
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Em ambas as passagens podemos ver que a decisão está fortemente relacionada com a comparação 

de diferentes pontos de vistas, alguns a favor e outros contra uma certa decisão. No nosso dia-a-dia 

podemos encontrar vários exemplos de problemas de decisão: “Qual o casaco a vestir?”, “Ir ao cinema 

ou ao futebol?” e de seguida, se a decisão for ir ao cinema, “Qual o filme a ver?”. Estes problemas são 

considerados problemas de decisão simples, como o exemplo da Figura 2.1. Neste exemplo, temos 

apenas uma decisão a tomar, “Levar guarda-chuva?”, e dois acontecimentos possíveis, “Chove” ou 

“Não chove”, o que resulta em quatro resultados diferentes. 

 

 

Figura 2.1 - Problema de decisão simples de levar o guarda-chuva 

 

Os problemas de decisão complexos são aqueles em que existem vários objetivos que entram em 

conflito com os restantes, e como tal não é fácil e é por vezes impossível encontrar uma decisão ótima: 

torna-se necessário encontrar a melhor relação possível entre os objetivos. Um exemplo de problema 

complexo é, num contexto empresarial, decidir sobre a construção de uma nova unidade de produção, 

qual a quantidade a produzir, qual o pessoal a contratar para essa unidade e qual o preço de venda 

dos produtos, com o objetivo de maximizar o lucro, e simultaneamente minimizar stocks e o impacto 

ambiental da nova unidade. 

A Figura 2.2 mostra um exemplo de um problema complexo. A primeira decisão a tomar é introduzir 

ou não o produto no mercado. Caso se escolha introduzir, existem dois acontecimentos possíveis, a 

introdução ou não de um produto concorrente. Tendo essa informação, é necessário decidir se o preço 

será alto, médio ou baixo. Por fim, caso tenha sido introduzido um produto concorrente, existem três 
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acontecimentos possíveis respeitantes ao preço desse produto. No total existem então 13 possíveis 

resultados distintos. 

 

Figura 2.2 - Exemplo de problema de decisão complexo (Havlicek et al., 2007) 

 

Para resolver um problema de decisão é normalmente seguido um conjunto sistemático de 

procedimentos.  

Em primeiro lugar é necessário identificar as várias alternativas de decisão. No problema do guarda-

chuva, as alternativas são apenas duas: levar ou não levar o guarda-chuva. No problema da escolha do 

filme a ver, as alternativas serão o conjunto de filmes em exibição no cinema. 

Em segundo lugar é necessário verificar se todas as alternativas respeitam as restrições impostas, e 

eliminar as que não as cumprem. Estas restrições podem ser de várias naturezas: no caso da escolha 
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do filme poderá haver a restrição de ser um filme “M-12”, devido à idade de uma das pessoas; na 

escolha de um automóvel para comprar, pode haver a restrição de um preço máximo que se tem 

disponibilidade para pagar. 

Por final, são definidos os critérios de avaliação, ou seja, os aspetos relevantes a ter em conta quando 

se vai tomar uma decisão. Por exemplo, na escolha do filme, alguns critérios poderão ser o género, a 

duração, a possibilidade de ver em 3D, etc. Na escolha de um automóvel podemos ter o consumo de 

combustível, a potência do motor, o número de lugares, a quantidade de extras, etc. A Figura 2.3 faz 

um resumo deste processo. 

 

 

Figura 2.3 - Resumo do processo de decisão 

 

Nas situações do dia-a-dia, as decisões são tomadas de forma informal, seguindo de forma geral os 

passos descritos. No entanto, em situações mais complexas ou em decisões tomadas em ambiente 

empresarial, é necessário seguir um procedimento formal que garanta a consistência do processo e 

justifique as opções tomadas. Na secção 2.3 será definido formalmente o paradigma de análise de 

decisão. 
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2.2 O que esperar da ajuda à decisão? 

Pode-se definir a ajuda à decisão (AD) como a atividade da pessoa que, através do uso de métodos 

explícitos mas não necessariamente completamente formalizados, ajuda a obter elementos de resposta 

para as questões de um participante num processo de decisão (Bernard Roy, 1996). Estes elementos 

visam clarificar a decisão e recomendar um comportamento que aumente a consistência entre a 

evolução do processo, os objetivos do participante e o sistema de valores. É importante reforçar o 

termo “recomendar”, pois é necessário ter em conta que o decisor é livre de tomar qualquer 

comportamento após esta recomendação ser feita. 

Assim definida, a AD visa, com base em princípios reconhecidos, a apresentação de soluções 

satisfatórias, elementos de resposta ou compromissos possíveis, que depois serão submetidos ao 

julgamento do decisor e/ou aos vários atores envolvidos no processo de tomada de decisão. Neste 

caso, a AD pode contribuir para: 

 Analisar o contexto de tomada de decisão ao identificar os atores, as várias possibilidade de 

ação, as suas consequências, etc. 

 Organizar e estruturar como o processo de tomada de decisão se vai desenrolar de forma a 

aumentar a coerência entre os valores associados aos objetivos e à decisão final. 

 Levar à cooperação entre atores através de termos para melhor compreensão mútua e um 

quadro mais favorável ao debate. 

 Elaborar recomendações utilizando resultados obtidos através de modelos e procedimentos 

computacionais concebidos dentro dum quadro de uma hipótese funcional. 

 Participar na legitimação da decisão final. 

Em alguns casos, aqueles que tentam objetivamente clarificar uma decisão, estão de facto a defender, 

consciente ou inconscientemente, uma posição definida anteriormente ou uma hipótese que tentam 

justificar (Armstrong, 1979). Mesmo só considerando as situações em que a AD é motivada por um 

desejo de objetividade, é importante ter em conta que existem algumas limitações fundamentais a esta 

objetividade, originadas nos seguintes factos: 

 A divisória entre o que é ou não exequível nem sempre é bem definida em contextos de 

decisão reais, e é frequentemente alterada com base no que é descoberto através do próprio 

estudo. 

 Mesmo nos casos em existe um decisor claramente identificado, nem sempre as suas 

preferências estão bem formadas. Entre as zonas de convicções firmes, existem zonas de 
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incerteza e crenças pouco convictas, que podem levar a efeitos imprevisíveis e indetetáveis 

aquando da interação com o analista. 

 Muitos dados são imprecisos, incertos ou mal definidos, e existe a possibilidade de lhes dar 

um significado mais importante do que o real. 

 Em geral, é impossível dizer se uma decisão é boa ou má com base apenas num modelo 

matemático. Aspetos organizacionais, pedagógicos e culturais, que levam à decisão, também 

contribuem para a sua qualidade e sucesso. 

2.3 Paradigma de análise de decisão 

Formalmente, o paradigma de análise de decisão pode ser definido em cinco etapas (Keeney & Raiffa, 

1993): 

 

Pré-análise 

A análise de decisão ocorre quando existe um agente de decisão que está indeciso quanto à decisão a 

tomar, face a um determinado problema. Nesta etapa identifica-se o problema bem como as diferentes 

alternativas possíveis de ação a tomar. 

 

Análise estrutural 

Nesta fase é feita uma estruturação do problema pelo agente de decisão. São definidas quais as 

decisões que pode tomar já, quais as decisões que pode deixar para o futuro, que informação obtém 

no momento, qual informação irá ter no futuro, etc. 

 

 

Figura 2.4 - Parte de árvore de decisão 
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O esquema da Figura 2.4 é uma árvore de decisão, que representa visualmente este tipo de estrutura. 

Os nós de decisão são aqueles que estão sob o controlo do agente de decisão e são representados por 

quadrados (1 e 3); os nós de acaso são aqueles fora do seu controlo, e são representados por círculos 

(2 e 4). O triângulo no final representa uma consequência. 

 

Análise de incerteza 

O agente de decisão atribui probabilidades a cada acontecimento possível associado aos nós de acaso. 

Cada um destes nós representa cada um dos possíveis acasos ou resultados que resultam desse 

acontecimento fora do controlo do agente de decisão. A atribuição destas probabilidades deve ser feita 

de acordo com o problema em questão, utilizando técnicas adequadas, dados passados, modelos de 

simulação, e opiniões de peritos ou do próprio agente de decisão. Por exemplo, no caso do problema 

do guarda-chuva da figura 2.1, a probabilidade de chover ou não poderia ser atribuída com base no 

boletim meteorológico. 

 

Utilidade ou análise de valor 

O agente de decisão atribui valores de utilidade a cada consequência associada a um caminho na 

árvore de decisão. A cada caminho na árvore estão associados, num problema real, vários custos e 

benefícios socioeconómicos que afetam o agente de decisão ou outros indivíduos envolvidos no 

problema. No caso do guarda-chuva, o primeiro caminho tem o custo de levar o guarda-chuva e o 

benefício de não se molhar. O agente de decisão deve codificar as preferências em termos de um valor 

de utilidade, de forma a permitir a utilização do critério de máxima utilidade esperada para a resolução 

do problema.  

 

Análise de otimização 

Depois da estruturação do problema e da atribuição de probabilidades e utilidades, o agente de 

decisão irá determinar a estratégia ótima, que será aquela que maximiza a utilidade esperada. Esta 

estratégia indica quais as ações a selecionar em cada nó de decisão. O critério da máxima utilidade 

esperada consiste em calcular, para cada nó de decisão, qual o valor esperado de cada decisão tendo 

em conta a utilidade das consequências possíveis e a probabilidade associada a cada uma, e escolher 

o nó de decisão com maior valor esperado. 
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2.4 Problemas de decisão 

Os problemas de decisão podem ser formulados de várias formas, ou segundo uma definição mais 

formal, podem estar enquadrados em várias problemáticas. É importante referir que a análise de 

decisão pode ser utilizada para outros fins que não apenas na perspetiva de resolução de um 

problema. Em alguns casos, o objetivo é apenas elaborar um conjunto de ações, criar um conjunto 

adequado de critérios e determinar, para algumas ou todas as alternativas, a sua performance. Este 

tipo de problemática é chamado de problemática de descrição ou cognição (P.δ). 

Para além desta problemática, os problemas de análise de decisão podem ainda ser categorizados em 

três outras problemáticas distintas (Roy, 1996): 

 Problemática de escolha (P.α): neste tipo de problemas o objetivo será a seleção de um 

conjunto pequeno de boas alternativas, de forma a se poder escolher uma única alternativa a 

recomendar. 

 Problemática de classificação (P.ȕ): neste caso o objetivo é atribuir cada alternativa a uma das 

categorias pré-estabelecidas, que poderão estar ordenadas ou não. 

 Problemática de ordenação (P.Ȗ): em casos de ordenação, o objetivo do problema é clarificar a 

decisão através de uma ordenação completa ou parcial das alternativas, que permite a sua 

comparação. 

2.5 Conceitos da teoria de decisão 

Depois da apresentação formal da teoria de decisão e dos vários problemas associados, será agora 

feita uma apresentação dos conceitos base que serão utilizados no próximo capítulo. 

 

Decisores 

O(s) decisor(es) ou agente(s) de decisão é(são) a(s) pessoa(s) ou grupo de pessoas que realiza(m) 

escolhas e que assume(m) preferências como um todo. O processo de decisão depende dos decisores, 

que apresentam valores diferentes, influenciados por cultura, religião, formação ou até a própria 

cultura organizacional onde estão inseridos. 
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Analista 

O analista é a entidade que tem o papel de selecionar o modelo a ser utilizado, obter informações 

necessárias para o modelo, interpretar os resultados e explicar aos decisores o mecanismo do modelo 

escolhido (Rogers et al., 2000). 

 

Modelo 

O modelo é uma representação de um problema real, que utiliza um conjunto de operações 

matemáticas para transformar os gostos e as opiniões dos decisores de forma a obter um resultado. 

Os modelos podem ser descritivos – representam o que os decisores fazem; ou normativos – 

representam o que os decisores devem fazer. 

 

Ator 

O ator é uma pessoa ou um grupo de pessoas que num processo de decisão influenciam direta ou 

indiretamente a decisão (Bana e Costa, 1995). 

 

Alternativa 

Uma alternativa ou ação potencial é aquilo que constitui o objeto de decisão ou aquilo ao qual o 

processo de decisão é dirigido. O processo de definição das alternativas é por vezes dos passos mais 

difíceis num processo de tomada de decisão. O conceito de alternativa corresponde ao caso particular 

em que a modelação implica que duas ações potenciais não podem ser executadas simultaneamente, 

o que é assumido implicitamente pela maioria dos autores, mas não é obrigatório (Figueira et al., 

2005). 

Sendo assim, o conjunto de alternativas, representado por A, é o conjunto das decisões que serão 

avaliadas num determinado momento do processo de decisão. O conjunto pode ser definido através de 

enumeração, quando é um conjunto finito, ou por caracterização as suas propriedades quando é um 

conjunto infinito ou de grande dimensão. Pode ainda ser um conjunto estável quando é definido a priori 

e não sofre alterações, ou evolutivo quando se altera durante o processo. 

Formalmente, uma alternativa deve ser caraterizada, para além da sua designação, pelos seus 

atributos, que a irão definir completamente no ponto de vista da decisão. É assumido que o conjunto 

das alternativas é apenas composto por aquelas que respeitam as restrições definidas para o 

problema. 
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Critérios 

Os critérios são ferramentas que permitem comparar as várias ações e alternativas em relação aos 

pontos de vista do agente de decisão. É importante que os critérios sejam independentes uns dos 

outros e devem ser também apropriados para o problema em particular. Ao selecionar um conjunto de 

critérios devemos ter que em conta que este deve ser: 

 Completo: deve cobrir todos os aspetos importantes do problema e todos os pontos de vista. 

 Operacional: deve poder ser utilizado na análise. 

 Decomponível: deve permitir a divisão do problema em partes, de forma a simplificar o 

processo de avaliação. 

 Não redundante: deve evitar que uma característica seja contada mais que uma vez. 

 Mínimo: deve manter o problema o mais pequeno possível. 

Voltando à definição de critério, a avaliação das alternativas deve ter em conta todos os efeitos 

permanentes ou atributos ligados ao ponto de vista considerado: chamamos a esta avaliação a 

performance em relação ao critério. Esta é medida normalmente em números reais, mas pode ser 

necessário definir explicitamente o conjunto de todas as possíveis avaliações. Por exemplo, tanto 

podemos medir um custo em euros, como podemos definir um critério como o conforto dentro de 

categorias: “Excelente”, “Bom”, “Razoável”, “Fraco”, “Mau”. Podemos distinguir vários tipos de 

escalas: 

 Escalas qualitativas ou puramente ordinais: escalas onde a diferença entre dois níveis 

diferentes não tem um significado claro em termos de diferentes preferências. Tanto podem 

ser escalas verbais ou escalas numéricas em que a mesma diferença entre valores não 

representa uma diferença invariante nas preferências. 

 Escalas quantitativas: escalas numéricas onde os níveis estão definidos através duma 

quantidade definida de forma clara e concreta, cujo significado é facilmente extraído.  

 Outros tipos de escalas intermédias, entre os dois tipos apresentados, também podem ser 

utilizados (Roy & Martel, 2006). 

É sempre importante ter em conta qual o tipo de escala com que se está a trabalhar de forma a poder 

utilizar os seus níveis de forma significante. É importante também lembrar que para algumas escalas, 

existem certos tipos de lógicas e operações aritméticas que têm importância em termos de 

preferências. 
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Objetivos 

Definidos os critérios, é necessário definir quais se devem maximizar ou minimizar e a que níveis. Os 

objetivos tomam então em consideração as necessidades ou desejos do agente de decisão, e 

representam as suas orientações de preferência para os critérios. Por exemplo, “preço” e “potência” 

são critérios, e “minimizar o custo” e “maximizar a potência” são objetivos. Como podemos ver por 

este exemplo, os objetivos podem ser conflituosos: carros com maior potência são também por norma 

mais caros. Existem casos em que se pode melhor simultaneamente dois objetivos, mas existem 

situações em que só podemos melhorar um objetivo à custa de outro. 

 

Figura 2.5 - Exemplo de hierarquia de objetivos 

 

No dia-a-dia, ao pensar nos objetivos de um problema, é comum criar uma hierarquia de objetivos, 

permitindo a sua estruturação (Figura 2.5). Começando por um objetivo genérico ou fundamental, faz-

se a divisão ou especificação do mesmo em objetivos de mais baixo nível, até estarmos perante 

objetivos diretamente relacionados com critérios. É necessário ter o cuidado de não aumentar a 

hierarquia para dimensões demasiado grandes, evitando introduzir objetivos pouco relevantes para o 

problema. 
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3. DECISÃO MULTICRITÉRIO 

Neste capítulo será feita uma revisão bibliográfica da análise de decisão multicritério (ADM). Será feita 

uma introdução, seguida de uma apresentação dos vários métodos e das várias ferramentas de 

software existentes. 

3.1 Introdução à decisão multicritério 

Antes de começarmos o estudo de decisão multicritério, é preciso fazer a distinção entre problemas 

simples e problemas multicritério. Os problemas simples são aqueles em que é possível atribuir 

objetivamente um único número a cada consequência possível. Vamos ilustrar este tipo de problemas 

com o exemplo da Figura 3.1.  

 

Figura 3.1 - Exemplo de problema de decisão simples 

 

Neste exemplo temos duas possíveis escolhas a1 e a2, e com base nas probabilidades e na utilidade 

de cada consequência, podemos calcular os valores esperados de cada uma delas: 

 ݁ሺܽͳሻ = ͸ ݁ሺܽʹሻ = Ͳ × Ͳ.ͷ + ͳͲ × Ͳ.ͷ = ͷ 
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A decisão a tomar neste caso seria a1, pois tem um valor esperado de utilidade superior.  

As dificuldades surgem quando a decisão se baseia em vários critérios, normalmente conflituosos. 

Nestes casos normalmente não é possível encontrar uma alternativa que seja melhor que as outras em 

todos os critérios simultaneamente. Torna-se necessária a intervenção do agente de decisão para 

chegar a uma conclusão, através duma conjugação das suas preferências com os atributos 

considerados para as várias alternativas. Pode-se dizer então que nos problemas multicritério não 

existe objetivamente uma solução ótima: existe apenas uma solução preferida, que pode variar entre 

agentes de decisão, dependendo da importância que dão a cada critério. 

 

Tabela 3.1 - Exemplos de critérios no problema de decisão de escolha do melhor carro 

Critério Objetivo Escala 

Preço Minimizar € 

Consumo Minimizar l/100km 

Conforto Maximizar (Excelente, Bom, Médio, Fraco, Mau) 

Segurança Maximizar Estrelas (1-5) 

Cilindrada Maximizar Cm3 

Potência Maximizar Cavalos 

Velocidade Máxima Maximizar Km/h 

 

 

Facilmente se compreende que pode não existir um critério único bem definido a priori, quer exista um 

único ou principalmente quando existem muitos agentes de decisão. É necessário ter em consideração 

os vários pontos de vista associados ao problema, como por exemplo, finanças, recursos humanos, 

aspetos ambientais, etc. Considerando cada ponto de vista separadamente, é geralmente possível 

obter uma expressão de preferências claras e concisas, permitindo associar um critério a cada ponto 

de vista pertinente. 

Poder-se-ia optar por uma abordagem monocritério, através da criação de uma única escala com uma 

unidade de medida comum para todos os critérios, que teria de ser introduzida a priori. No entanto, 

esta abordagem poderia levar a: 

 Negligenciar erradamente alguns aspetos da realidade. 

 Facilitar a criação de equivalências cuja natureza fictícia permanece invisível. 
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 Tender a apresentar características de um sistema de valores em particular como objetivo. 

Por outro lado, uma abordagem multicritério contribui para evitar estes perigos através de: 

 Delimitação do vasto espectro de pontos de vista que irão estruturar o processo de decisão 

relacionando com os atores envolvidos. 

 Construção de um conjunto de critérios que preserva, para cada um deles e sem conversão 

fictícia, o significado original concreto das avaliações correspondentes. 

 Facilita o debate sobre o papel que cada critério poderá vir a ter durante o processo de 

decisão. 

3.2 Modelação de preferências 

Uma das fases mais importantes na análise de decisão multicritério é a fase da agregação de 

preferências, que consiste na construção de um sistema de preferências usando procedimentos de 

agregação multicritério. 

É importante estabelecer as relações de preferência, fazer a sua explicitação clara e a sua 

interpretação. Estas podem ser divididas em quatro situações binárias (Roy, 1996): 

 Indiferença (a I b): há razões que justificam a indiferença na escolha entre as duas alternativas. 

 Preferência estrita (a P b): existem fatores que provam o favorecimento da alternativa a em 

relação à alternativa b. 

 Preferência fraca (a Q b): existe dúvida entre (a I b) e (a P b). 

 Incomparabilidade (a J b): não existem razões que justifiquem nenhuma das situações 

anteriores. 

3.3 Métodos de ADM 

Depois de feita a introdução à ADM vamos então apresentar alguns dos métodos multicritério 

existentes. A maioria dos autores divide estes métodos em três famílias de abordagens (Vincke, 1992): 

 Escola Americana ou Teoria da Utilidade Multiatributo (MAUT). 

 Escola Francesa/Europeia ou Métodos de Subordinação e Síntese. 

 Métodos Interativos ou de Programação Matemática Multiobjectivo. 
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Nesta secção será feita uma breve apresentação dos principais métodos das Escolas Americana e 

Francesa. Na secção 4.5 serão apresentados os cálculos associados a alguns dos métodos 

apresentados. 

 

3.3.1 Escola Americana ou MAUT 

A Escola Americana, baseada na teoria da utilidade, foi a linha de pensamento pioneira na decisão 

multicritério. Os métodos desta escola caracterizam-se por auxiliar o decisor a construir uma função 

utilidade representativa das suas preferências. A tabela 3.1 lista os principais métodos desta escola. 

Tabela 3.2 - Métodos da Escola Americana 

Método Descrição 
AHP O Analytic Hierarchic Process é um método baseado em comparações entre 

alternativas e na medição de preferências com base no uso de escalas. 
Decompõe o problema em níveis hierárquicos, facilitando a sua 
compreensão e avaliação (Saaty, 1980). 

MACBETH Measuring Attractiveness by a Categorical based Evaluation Technique. É 
um método de comparação que utiliza escalas ordinais por intervalo. As 
licitações de preferências são realizadas usando seis referências semânticas 
introduzidas numa matriz que garante a consistência das mesmas (Bana e 
Costa & Vansnick, 1997). 

Ponto Médio Método para construção de funções utilidade (Chankong & Hamies, 1983). 
Programação por 
Metas 

Exige que o decisor declare a sua preferência indicando a meta que deseja 
alcançar. Permite ordenar todas as alternativas a partir da distância de cada 
uma delas em relação a essa meta (Lee, 1972). 

Smarts Simple Multi-Attribute Rating Technique using Swings. Auxilia a construção 
de funções de utilidade aproximando-as por funções lineares (Edwards & 
Barron, 1994). 

Smarts Intervalar Auxilia a construção de funções de utilidade introduzindo nelas a imprecisão 
dos julgamentos do decisor (Mustajoki et al., 2005). 

Smarter Simple Multi-Attribute Rating Technique Exploiting Ranks. Método similar ao 
Smarts que aproxima as funções de utilidade por funções lineares e estima 
o peso de cada critério por uma técnica chamada Rank Order Centroid 
(Edwards & Barron, 1994). 

TODIM Tomada de Decisão Interativa Multicritério. Método multicritério baseado na 
Teoria dos Prospetos (Gomes et al., 2004). 

UTA Os métodos UTA (Utilitès Additives) procuram inferir uma ou mais funções 
de valor aditivas através de uma dada ordenação num conjunto de 
referência, utilizando técnicas especiais de programação linear (Jacquet-
Lagreze & Siskos, 1982). Existem muitas variantes deste método, que foram 
comparadas em (Beuthe & Scannella, 2001). 

UTADIS Utilités Additives Discriminantes. Classifica alternativas em categorias 
predefinidas pela simples comparação entre o valor da função utilidade 
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global para cada alternativa e constantes usadas para delimitar cada classe 
(Zopounidis & Doumpos, 1999). 

 

3.3.2 Escola Francesa 

Nos métodos de decisão da Escola Francesa encontramos duas fases distintas. Numa primeira fase é 

feita uma comparação entre todas as alternativas, de forma a estabelecer relações de 

sobreclassificação. Na segunda fase essas relações são utilizadas de forma a obter uma ordenação das 

alternativas, uma classificação em categorias ou obter a melhor alternativa. Na tabela seguinte listam-

se os principais métodos desta escola. 

 

Tabela 3.3 - Métodos da Escola Francesa 

Método Descrição 
Argus Utiliza valores qualitativos para representar a intensidade de preferência 

numa escala ordinal (De Keyser & Peeters, 1994). 
Electre I Elimination and Choice Translating Reality. Baseia-se no conceito de 

concordância e discordância para construir as relações de 
sobreclassificação entre as alternativas. Essas relações definem um grafo a 
partir do qual é possível definir o menor conjunto de alternativas 
consideradas satisfatórias (Roy, 1968). 

Electre II Método usado para ordenar as alternativas da melhor até à pior, tendo 
como dados de entrada os resultados obtidos pelo método Electre I (Roy & 
Bertier, 1973). 

Electre III Utiliza os conceitos de relação de sobreclassificação e índice de 
credibilidade para ordenar as alternativas da melhor à pior (Roy, 1978). 

Electre IV Método usado para ordenar as alternativas, mas que oferece a vantagem de 
não exigir a especificação do peso de cada critério (Roy, 1991). 

Electre Tri Método baseado em relações de sobreclassificação usado para classificar as 
alternativas em categorias predefinidas, a partir da comparação entre cada 
alternativa e os perfis que definem os limites das categorias (Yu, 1992). 

Evamix O método Evamix é uma generalização da análise de concordância no caso 
de informação mista na avaliação de alternativas, e permite obter uma 
ordenação das mesmas (Voogd, 1982). 

Oreste Método baseado no conceito de sobreclassificação, usado para ordenar as 
alternativas da melhor até à pior (Roubens, 1982). 

Promethee I Preference Ranking Organization Method for Enrichment Evaluations. Usa o 
conceito de fluxo de rede da teoria de grafos para construir as relações de 
sobreclassificação e ordenar as alternativas da melhor até à pior. Admite 
situações em que a preferência do decisor é indefinida e as alternativas são 
consideradas incomparáveis (Brans & Vincke, 1985). 

Promethee II Método similar ao Promethee I que não admite julgamentos em que as 
alternativas são incomparáveis (Brans & Vincke, 1985). 
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Promethee V Método que começa por executar o Promethee II, seguido de um método de 
busca até se encontrar a alternativa que respeita uma série de restrições 
sobre o valor do fluxo de rede e que está melhor colocada na ordenação 
(Gomes et al., 2004). 

Qualiflex É um procedimento métrico baseado na avaliação de todas as possíveis 
permutações das alternativas consideradas (Paelinck, 1976). 

Regime É um método que pode ser visto como uma generalização ordinal de 
métodos de comparação a pares, tal como a análise de concordância 
(Hinloopen et al., 1983). 

Topsis Technique for Order Preference by Similarity to Ideal Solution. Estabelece 
relações de sobreclassificação entre alternativas com base nas distâncias 
entre cada alternativa e as soluções ideais positiva e negativa (Yoon & 
Hwang, 1995). 

 

 

3.4 Ferramentas de Software de ADM 

Nesta secção será feita uma apresentação das várias ferramentas de software de ADM existentes. Este 

levantamento foi realizado com base no trabalho de Tereso e Seixedo (2010) e de Figueira et al. 

(2005), atualizando-o com outras ferramentas mais modernas que foram sido desenvolvidas. As 

ferramentas serão divididas em seis grupos distintos: estruturação qualitativa de problemas, decisões 

com múltiplos atributos, decisões com múltiplos objetivos, ordenação de problemas, decisões em 

grupo e aplicações específicas. 

 

3.4.1 Estruturação qualitativa de problemas 

As ferramentas de software desta categoria focam-se nas fases iniciais do processo de tomada de 

decisão: exploração e formulação do problema. 

 

Tabela 3.4 - Software de estruturação qualitativa de problemas 

Software Descrição 
Decision Explorer Software orientado à organização e mapeamento de informação qualitativa 

para problemas complexos e mal estruturados (White & Palocsay, 1999). 
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3.4.2 Decisões com múltiplos atributos 

Neste tipo de software, o decisor deve escolher entre um número finito de alternativas caracterizadas 

por um conjunto de atributos. Estes pacotes de software estão desenhados para lidar com qualquer 

tipo de problema de decisão que respeite esse formato. 

 
Tabela 3.5 - Software de decisão com múltiplos critérios 

Software Descrição 
BeSmart Software académico que utiliza os métodos SMART, AHP e Funções de Valor para 

resolver problemas multicritério genéricos (Tereso et al., 2011). 
Criterium 
Decision Plus 

Software com análise gráfica de sensibilidade com base nos métodos AHP e pesos 
simples. Revisto em (Haerer, 2000). 

DAM – 
Decision 
Analysis 
Module 

Originalmente desenhado como um módulo de um software complexo, utiliza 
informação imprecisa sobre trade-offs na forma de intervalos (Podinovski, 1999). 

Decision Lab Previamente conhecido como PROMCALC, implementa o método Promethee e o 
método visual GAIA (Geldermann & Zhang, 2002). 

ElecCalc Software com interface gráfica intuitiva que permite ao utilizador exprimir 
preferências globais que serão utilizadas para o método Electre II. 

Electre IS Software que utiliza uma generalização do método Electre I que permite pseudo-
critérios (http://www.lamsade.dauphine.fr/spip.php?rubrique65). 

Electre III-IV Implementa os métodos Electre III e Electre IV 
(http://www.lamsade.dauphine.fr/spip.php?rubrique66). 

Equity Software com um método dividido em várias fases que permite obter o melhor valor 
pelo dinheiro na alocação de recursos escassos 
(http://www.catalyze.co.uk/index.php/software/equity3/). 

Expert Choice Software baseado na metodologia AHP que dá ênfase à interface fácil de utilizar e 
suporte à decisão em grupo. Revisto em Fernandez (1996) e em Zapatero et al. 
(1997). 

Hiview Ferramenta que dá apoio à decisão entre opções mutualmente exclusivas 
(http://www.catalyze.co.uk/index.php/software/hiview3). 

Logical 
Decisions 

Software que permite estruturação e análise de problemas de decisão com 
múltiplos atributos, que se foca numa interface muito apelativa. Revisto em 
Zapatero et al. (1997). 

MACBETH Software que implementa o método MACBETH (Bana e Costa & Chagas, 2004). 
MacModel Ferramenta baseada em árvores de decisão para problemas multicritério 

(http://www.civil.ist.utl.pt/~lavt/software.html). 
M&P 
(MAPPACC 
and PRAGMA) 

Implementa os métodos de sobreclassificação MAPPACC (Matarazzo, 1986) e 
PRAGMA (Matarazzo, 1988). 

MIIDAS Software baseado no método UTA II (Siskos et al., 1999). 
MINORA Sistema de suporte à decisão interativo baseado no método UTA (Siskos et al., 

1993). 
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Mustard Software que implementa variantes dos métodos UTA e Quasi-UTA (Beuthe & 
Scannela, 1999). 

NAIADE Software que implementa o método NAIADE ("NAIADE Manual and Tutorial," 1996). 
OnBalance Software com uma abordagem similar ao AHP, baseada numa atribuição simples de 

pesos e comparações 
(http://www.quartzstar.com/index.php?option=com_content&view=article&id=5&Ite
mid=3). 

Prefcalc Implementação mais antiga do método UTA (Jacquet-Lagrèze, 1990). 
PRIAM Software que utilizada uma abordagem interativa não estruturada para encontrar a 

alternativa mais desejável (Levine & Pomerol, 1986). 
PRIME 
Decisions 

Software baseado no método PRIME que sublinha a sua capacidade de utilizar 
informação incompleta sobre preferências (Gustafsson et al., 2001). 

REMBRANDT Implementa o método REMBRANDT que requer comparações entre os vários 
critérios e entre as várias alternativas (Lootsma, 1992). 

RGDB Ferramenta que permite a seleção de itens preferidos em listas de grande tamanho, 
utilizando uma interface gráfica simples 
(http://www.ccas.ru/mmes/mmeda/rgdb/index.htm). 

Sanna É um add-on do Microsoft Excel que permite resolução de problemas multicritério 
utilizando vários métodos (WSA, Topsis, Electre I, Promethee II e MAPPACC) 
(Jablonský, 2001). 

TOPSIS Software que implementa o método TOPSIS (Yoon & Hwang, 1995). 
UTA Plus Implementação mais recente em ambiente Windows do método UTA. 
VIMDA Sistema visual de suporte à decisão multicritério (Korhonen, 1988). Revisto em 

Zapatero et al. (1997). 
VIP Analysis Software baseado em funções de valor aditivas básicas, que permite ao decisor 

introduzir informação imprecisa nos parâmetros de importância dos critérios (Dias & 
Clímaco, 2000). 

VISA Ferramenta uma interface gráfica intuitiva baseada em funções de valor lineares 
multicritério. Revisto em Zapatero et al. (1997). 

Web-HIPRE Software baseado no browser de internet que utiliza os métodos AHP, Funções de 
valor e SMART (Mustajoki & Hamalainen, 2000). 

WINPRE Software baseado na metodologia PAIRS que permite ao decisor estabelecer um 
intervalo de números para indicar preferências entre alternativas (Salo & 
Hämäläinen, 1995). 

 

 

3.4.3 Decisão com múltiplos objetivos 

Em modelos com múltiplos objetivos, os critérios são expressos na forma de funções objetivo 

matemáticas que serão otimizadas. Estes modelos podem envolver funções objetivo lineares ou não 

lineares, e podem ter variáveis de decisão inteiras ou contínuas. 
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Tabela 3.6 - Software de decisão com múltiplos objetivos 

Software Descrição 

ADBASE Software que implementa métodos de programação multiobjectivo linear 
para enumerar pontos extremos e arestas eficientes ilimitadas (Steuer, 
1992). 

FGM (Feasible 
Goals Method) 

Software que permite a exploração gráfica de resultados de todas as 
decisões possíveis (Lotov et al., 2001). 

FSCS (Feasible Set 
in Criterion Space) 

Software que permite a visualização do conjunto possível de resultados no 
espaço de critérios para problemas não lineares (Lotov et al., 2001). 

MultiGen Ferramenta que incorpora um sistema de otimização e um solucionador 
de algoritmos heurísticos genéticos (Mirrazavi et al., 2003). 

Multistat Optimizer Ferramenta baseada num método de visualização para modelos por 
projeção (Papadrakis et al., 2003). 

SOLVEX Pacote de aplicações para resolução de problemas de otimização não 
linear sem restrições, problemas de otimização global multivariável e 
problemas multicritério não lineares 
(http://www.ccas.ru/pma/product.htm). 

Trimap Abordagem interativa que explora o conjunto Pareto-ótimo para modelos 
de programação linear com três critérios (Climaco & Henggeler Antunes, 
1989). 

Tommix Pacote interativo e flexível que incorpora vários métodos (STEM, Zionts-
Wallenius, intervalos de pesos de critérios, corrida de Pareto, Trimap) 
(Antunes et al., 1992). 

VIG Sistema de suporte à decisão visual, dinâmico e interativo, que suporta 
matrizes de restrições de programação linear até 96 colunas e 100 linhas 
(http://www.numplan.fi/vig/vigeng.htm). 

WWW-Nimbus Software desenhado para resolver problemas de otimização com um ou 
vários objetivos que possam ou não ser diferenciáveis, sujeitos a restrições 
lineares e não lineares com limites nas variáveis (Miettinen & Mäkelä, 
2000). 

3.4.4 Problemas de ordenação 

Os pacotes de software deste tipo visam classificar as alternativas em grupos ou classes predefinidas. 

 

Tabela 3.7 - Software de problemas de ordenação 

Software Descrição 

Electre Tri Software que implementa o método Electre Tri (Yu, 1992). 

IRIS Sistema de suporte à decisão para classificar as alternativas em categorias 

ordenadas predefinidas, com base nas suas avaliações em múltiplos 

critérios (Dias et al., 2002). 
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Prefdis Software baseado numa abordagem de desagregação de preferências, 

com várias técnicas de ordenação disponíveis (Zopounidis & Doumpos, 

2000). 

TOMASO Ferramenta em Visual Basic para ordenação na presença de pontos de 

vista qualitativos interativos (Roubens, 2002). 

 

 

3.4.5 Decisão em grupo 

Os programas nesta categoria lidam com a situação específica da existência de múltiplos decisores.  

Tabela 3.8 - Software para decisão em grupo 

Software Descrição 
AGAP Sistema de suporte à decisão distribuído, que permite a múltiplos 

decisores cooperaram na avaliação e seleção de projetos de investimento. 
Permite utilização síncrona ou assíncrona (Costa et al., 2003). 

Argos Ferramenta que facilita a pequenos grupos a ordenação de projetos ou 
candidatos, utilizando métodos de ordenação (Colson, 2000). 

GMCR Sistema de suporte à decisão que permite modelar decisões estratégicas, 
prever soluções de compromisso e assistir no estudo de viabilidade 
política, económica, ambiental e social de vários cenários alternativos 
(Hipel et al., 1997). 

Joint Gains Software de suporte à negociação baseado no método de direções 
melhoradas (Ehtamo et al., 1999). 

Mediator Sistema de suporte à negociação baseado no desenho de sistemas 
evolucionários e com uma implementação centrada na base de dados 
(Jarke et al., 1987). 

SCDAS Ferramenta desenhada para suportar grupos que têm um objetivo comum 
e necessitam de trabalhar em conjunto para selecionar a melhor 
alternativa (Lewandowski, 1989). 

WINGDSS Sistema de suporte à decisão em grupo para problemas com múltiplos 
atributos (Csáki et al., 1995). 
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3.4.6 Aplicações específicas 

Estas ferramentas foram desenvolvidas com vista a aplicações muito específicas. 

 

Tabela 3.9 - Software para uso em aplicações específicas 

Software Aplicação 
ACADEA Avaliação de performance de docentes universitários (Agrell & Steuer, 

2000). 
Agent Allocator Alocação de tarefas (Matsatsinis & Delias, 2003). 
Auto Man Investimentos em sistemas de manufatura automatizados (Weber & 

Lippiatt, 1989). 
Bank Advisor Análise financeira (Mareschal & Brans, 1991). 
CASTART Selecionar alternativas de produção de eletricidade (Gandibleux, 1999). 
CGX Suporte a decisões de termos de crédito em instituições não financeiras 

(Srinivasan & Ruparel, 1990). 
DIDASN++ Modelação de aplicações de engenharia (Granat, 1994). 
Dimitra Desenvolvimento de produtos agrícolas (Matsatsinis & Siskos, 2001). 
ESY Decisões durante emergências nucleares (Papamichail & French, 2000). 
FINCLAS Ferramentas de modelação financeira (Zopounidis & Doumpos, 1998). 
Fineva Avaliação de performance empresarial e viabilidade (Zopounidis et al., 

1996). 
INVEX Seleção de projetos de investimento de capital (Vraneš et al., 1996). 
MARKEX Suporte a várias fases do processo de desenvolvimento de produto 

(Matsatsinis & Siskos, 1999). 
Medics Ajuda a diagnóstico médico (Bois et al., 1989). 
Moira Seleção de estratégias de recuperação de sistemas de água após 

introdução a substâncias radioativas (Insua et al., 2000). 
SANEX Viabilidade de adequação de sistemas sanitários (Loetscher, 2000). 
Skills Evaluator Avaliação das qualificações e capacidades de um indivíduo ao nível das 

Tecnologias de Informação (Anestis et al., 2006). 
TELOS Avaliação da satisfação do cliente (Grigoroudis et al., 2000). 
Water Quality 
Planning DSS 

Escolha de estratégias ideais de tratamento de água (Lotov et al., 1997). 
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4. DESENVOLVIMENTO DO SOFTWARE BESMART 2 

Neste capítulo apresenta-se o processo de desenvolvimento do software BeSmart 2, incluindo a 

linguagem de programação escolhida, os elementos presentes na ferramenta e os métodos de cálculo 

utilizados.  

4.1 Software BeSmart 

A primeira versão do software BeSmart (Tereso et al., 2011) é uma ferramenta desenvolvida na 

linguagem C# (http://msdn.microsoft.com/en-us/vstudio/hh341490.aspx) e que implementa os 

métodos de decisão multicritério AHP (Saaty, 1980), SMART (Edwards & Barron, 1994) e Value 

Functions (Dyer & Sarin, 1979). 

 

 

Figura 4.1 - Software BeSmart 

 

Na versão original o software permite a comparação de até 16 alternativas, com um número ilimitado 

de critérios com escalas numéricas ou qualitativas. Permite ainda a gravação consistente de todos os 

modelos criados. 
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No desenvolvimento do software BeSmart 2, tomou-se como base a versão original e foram 

adicionadas algumas funcionalidades novas, tais como: 

 Remodelação da interface gráfica para uma mais intuitiva. 

 Suporte a uma hierarquia multinível de critérios. 

 Análise detalhada dos resultados. 

 Análise de sensibilidade dos resultados. 

 Gravação de resultados e de cálculos incompletos para utilização posterior. 

4.2 Especificação do software desenvolvido 

Antes do desenvolvimento do software, é necessário efetuar a especificação do mesmo através de 

diagramas UML (http://en.wikipedia.org/wiki/Unified_Modeling_Language), nomeadamente o 

diagrama de classes e o diagrama de casos de uso. 

 

O diagrama de classes (Figura 4.2) é um diagrama que descreve a estrutura do sistema, mostrando as 

suas classes, atributos, métodos ou operações e os relacionamentos entre os vários objetos. A 

ferramenta está dividida em dois grupos de classes: o grupo da camada de dados e modelo de negócio 

(Business) e o grupo de classes da interface gráfica (Interface). 

 

Podemos também dividir as classes em dois grupos funcionais. No primeiro grupo temos as classes 

associadas com a gestão do modelo (alternativas, critérios e categorias). No lado da camada de dados, 

temos a classe Manager que contém a lista de critérios, categorias e valores das alternativas. Temos 

ainda a classe Criterion (representa um critério), Category (representa uma categoria), Scale e as suas 

derivadas (representam os vários tipos de escala de valores) e ainda a classe ManagerSerializer que 

efetua a gravação e leitura da classe Manager. Do lado da interface temos o menu principal (Main) e os 

menus associados à edição de alternativas (AlternativeMenu), critérios (CriterionMenu) e categorias 

(CategoryMenu). 
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Figura 4.2 - Diagrama de classes UML do software BeSmart2 

 

No segundo grupo encontram-se as classes associadas às comparações e resultados. Do lado da 

camada de dados, a classe Comparison contém as pontuações para todos os critérios e categorias, 

bem como todos os métodos de cálculo. A classe Score armazena as pontuações para um critério ou 

categoria, sendo composta por 4 classes que representam os vários métodos (AHPScore, 

ValueFnScore, DirectScore, SmartScore). A classe ComparisonSerializer efetua a gravação e leitura da 

classe Comparsion. Do lado da interface, a classe MenuComparison é a classe principal que contém 

toda a interface de cálculo dos resultados. Temos ainda a classe AlternativeChooser que representa o 

menu de escolha de alternativas antes de iniciar uma comparação, e a classe ShowValuesMenu que 

mostra os valores das alternativas para um dado critério. 

 

O diagrama de casos de uso (Figura 4.3) representa as várias formas que o utilizador interage com o 

sistema. Podemos dividir estas interações em três grupos distintos: persistência do modelo (Novo 

Modelo, Abrir Modelo e Gravar Modelo), edição do modelo (Adicionar/Editar/Remover Critério, 
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Adicionar/Editar/Remover Categoria, Editar Alternativas) e comparações (Nova Comparação, Abrir 

Comparação e Gravar Comparação). O caso de uso “Nova Comparação” inclui casos de uso mais 

específicos, tais como “Escolher Alternativas” e “Preencher Valores”, este último podendo tomar 

quatro formas distintas de acordo com o método escolhido. 

 

Figura 4.3 - Diagrama de casos de uso 

 

4.3 Linguagem de programação e ferramentas utilizadas 

De modo a poder utilizar parte do trabalho desenvolvido na ferramenta original, a linguagem de 

programação escolhida para o desenvolvimento do BeSmart 2 foi a linguagem C# 

(http://msdn.microsoft.com/en-us/vstudio/hh341490.aspx). Para a interface gráfica foi utilizada a 

framework Windows Forms (Microsoft Windows Forms WebPage - http://msdn.microsoft.com/en-

us/library/dd30h2yb(v=vs.110).aspx) 
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Todo o trabalho foi realizado na ferramenta Visual Studio 2013 (http://www.visualstudio.com/), com 

apoio da extensão Installer Projects 

(http://blogs.msdn.com/b/visualstudio/archive/2014/04/17/visual-studio-installer-projects-

extension.asp) para a criação do instalador do software. 

 

 

Figura 4.4 - Janela do Visual Studio 2013 com parte do código 

4.4 Elementos principais do software 

Os modelos criados no software são feitos em vários níveis hierárquicos, baseados no método AHP 

(Saaty, 1980). No topo desta hierarquia temos os objetivos fundamentais, de seguida os objetivos 

intermédios, depois os objetivos dos decisores, e por final os possíveis resultados ou cenários. 

 

No software, os objetivos fundamentais e intermédios são chamados de categorias, os objetivos dos 

decisores são os critérios e os resultados são as alternativas. De seguida serão analisados ao pormenor 

estes três elementos. 

4.4.1 Categorias 

Uma categoria corresponde a um nível superior ou intermédio num modelo hierárquico. Cada categoria 

pode ter vários critérios ou subcategorias associados. Na figura seguinte encontramos um exemplo de 

uma hierarquia, na qual encontramos 3 categorias: “Melhor Carro”, “Performance” e “Economia”. 
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Figura 4.5 - Hierarquia do modelo-exemplo 1 

4.4.2 Critérios 

Um critério pode ser definido formalmente como uma ferramenta que permite comparar as ações em 

relação aos pontos de vista de cada agente de decisão (Roy, 1996). Na ferramenta, um critério 

constitui uma das várias métricas nas quais se podem avaliar as alternativas. No exemplo da Figura 

4.5, os critérios são “Potência”, “Binário”, “Preço” e “Consumo”. 

 

A ferramenta permite definir critérios com 3 tipos de escalas diferentes: escala numérica, escala 

discreta ou escala binária. 

 

Escala numérica 

Numa escala numérica, o critério será medido dentro dum conjunto contínuo de valores. Este conjunto 

poderá ter um valor mínimo e um valor máximo definido. Também terá de ser definida a unidade na 

qual se mede o critério, e se o objetivo será de minimizar ou maximizar o valor. 
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Figura 4.6 - Exemplo de critério com escala numérica 

Escala Discreta 

Numa escala discreta são definidos extensivamente os vários valores que as alternativas poderão tomar 

nesse critério. Também terá de ser definida a ordem de preferência desses mesmos valores. 

 

Figura 4.7 - Exemplo de critério com escala discreta 

Escala binária 

Uma escala binária adequa-se, como o nome indica, a critérios nos quais as alternativas poderão 

apenas tomar dois valores (Sim/Não, Verdadeiro/Falso, etc.). 

 

Figura 4.8 - Exemplo de critério com escala binária 
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4.4.3 Alternativas 

As alternativas serão as várias escolhas possíveis do problema de decisão a ser analisado, e que serão 

avaliadas segundo os critérios definidos. No exemplo da Figura 4.5, as alternativas são “Opel Astra” e 

“Peugeot 206”. 

4.5 Métodos e cálculos utilizados 

Para demonstrar os métodos utilizados e a forma de cálculo, iremos considerar o modelo-exemplo 2, 

cuja hierarquia está definida na Figura 4.9. 

 

Figura 4.9 - Hierarquia do modelo-exemplo 2 

As escalas dos critérios são as apresentadas na Secção 4.4.2, e as alternativas têm os valores 

apresentados na Tabela 4.1. 

 
Tabela 4.1 - Valores do modelo-exemplo 2 

Candidato Média Área de estudos Disponibilidade 

João Ferreira 16,5 Informática Não 

Pedro Silva 18 Economia Sim 

Maria Alves 17,2 Eng. Eletrónica Sim 
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4.5.1 Pesos diretos 

Na atribuição de pesos diretos não são efetuados cálculos; os valores introduzidos são os pesos 

atribuídos aos subcritérios/subcategorias ou às alternativas, consoante se tratar de uma categoria ou 

critério, respetivamente.  

 

No caso de se tratar de uma categoria, os pesos a atribuir corresponderão à importância em 

percentagem de cada subcategoria/subcritério nessa categoria. Como tal, a soma destes pesos deverá 

ser igual a 1, e não poderá haver pesos inferiores a 0 ou superiores a 1. 

 

No caso de se tratar de um critério, os pesos a atribuir corresponderão à importância de cada 

alternativa em relação ao valor ideal para esse critério, que corresponderá ao valor máximo de 1. 

 

Tomando como exemplo o critério “Disponibilidade”, o avaliador define que o ideal será haver 

disponibilidade imediata (valor “Sim”) e dará uma penalização de 25% aos candidatos sem 

disponibilidade (valor “Não”). Assim, as pontuações a atribuir serão as da tabela seguinte. 

Tabela 4.2 - Pontuações atribuídas às alternativas no critério Disponibilidade 

Candidato Pontuação 

João Ferreira 0,75 

Pedro Silva 1 

Maria Alves 1 
 

4.5.2 Funções de valor 

As funções de valor são funções que atribuem um valor a cada uma das alternativas baseadas no 

conceito de diferenças de preferência (Dyer & Sarin, 1979). Como utilizam os valores das alternativas, 

apenas podem ser utilizadas para atribuir pontuações às alternativas em cada critério. 

 

O primeiro passo para calcular o peso de uma alternativa, é transformar o valor desta num valor entre 

0 e 1. Esta conversão inicial será feita de forma linear, e é feita de forma diferente caso se trate de um 

critério com escala numérica, discreta ou binária. 
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No caso de uma escala discreta com N valores, o primeiro passo é atribuir uma pontuação incremental 

a cada valor: 0 pontos ao pior, 1 ponto ao seguinte, até N – 1 pontos ao melhor valor da escala. O 

valor linear será calculado através da fórmula: 

ሺ�ሻ ݎ݈ܽ݁݊݅ ݎ݋݈ܽ�  = ሺ�ሻܰ ݋çãܽݑݐ݊݋�  − ͳ  

 

A tabela seguinte mostra os valores que seriam obtidos se utilizássemos estes cálculos no critério 

“Área de Estudos”. 

Tabela 4.3 - Exemplo de cálculo de valor linear para uma escala discreta 

Área Pontuação Valor Linear 

Informática 3 1 

Outras Engenharias 2 0,67 

Economia / Gestão 1 0,33 

Outras Áreas 0 0 
 

Nas escalas discretas, o cálculo é efetuado com base nos valores das alternativas, e dos valores 

mínimos e máximos definidos para o critério. Estes limites podem ser definidos pelo analista, ou 

podem ser baseados nos valores existentes, isto é, o máximo e mínimo serão respetivamente o maior e 

menor valor existente nas alternativas. Para um critério cujo objetivo é maximizar o valor, o cálculo é 

feito da seguinte forma: 

ሺ�ሻ ݎ݈ܽ݁݊݅ ݎ݋݈ܽ�  =  � − ݉݅݊݉ܽ� − ݉݅݊ 

 

No caso de o objetivo ser minimizar o valor, a fórmula é a seguinte: 

ሺ�ሻ ݎ݈ܽ݁݊݅ ݎ݋݈ܽ�  =  ݉ܽ� − �݉ܽ� − ݉݅݊ 

 

Tomando como exemplo o critério “Média”, e definindo o valor mínimo como 141, e o valor máximo 

como 20, teríamos os seguintes valores lineares: 

                                                 

1 Neste exemplo, o valor mínimo definido pelo avaliador é de 14 valores. Num exemplo mais genérico, deveria ser utilizado o 
valor 10, ou outro mais adequado ao problema. 
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Tabela 4.4 - Exemplo de cálculo de valor linear para uma escala numérica 

Candidato Média Valor linear 

João Ferreira 16,5 0,42 

Pedro Silva 18 0,67 

Maria Alves 17,2 0,53 
 

 

Para escalas binárias, será atribuído o valor linear 0 ao valor “Não/Falso” e 1 ao valor 

“Sim/Verdadeiro”, ou o contrário, caso o valor “Não/Falso” seja o preferido no critério considerado. 

No entanto, não é muito aconselhável utilizar funções de valor para este tipo de escalas. 

 

Após calculado o valor linear, são tomadas em conta as diferenças de preferência do analista. Caso 

estas diferenças sejam constantes, isto é, a mesma diferença de valores causa a mesma diferença de 

preferência independentemente dos valores, então a função de valor será igual ao valor linear.  

 ��ሺ�ሻ =  ሺ�ሻ ݎ݈ܽ݁݊݅ ݎ݋݈ܽ�

 

Nos outros casos, será utilizado um fator de preferência α. Caso o analista tenha preferência em 

diferenças nos valores mais próximos do máximo, o valor de α será positivo. Caso a preferência recaia 

sobre diferenças nos valores mais próximos do mínimo, o valor de α será negativo. Quanto mais fortes 

forem estas preferências, mais positivo ou negativo será o valor de α. A função de valor será então 

calculada da seguinte forma: 

 ��ሺ�ሻ = ݁�∗��௟௢� ௟௜௡���ሺ�ሻ − ͳ݁� − ͳ  

 

Continuando a utilizar o critério “Média”, o avaliador dá mais importância à diferença entre as médias 

19 e 20 do que entre as médias 14 e 15. Sendo assim, o valor de α será positivo. Com α  = 1, o 

gráfico da função de valor será o seguinte: 
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Figura 4.10 - Exemplo de gráfico de função de valor com α = 1 

As pontuações a atribuir serão então: 

 

Tabela 4.5 - Pontuações atribuídas às alternativas no critério Média 

Candidato Pontuação 

João Ferreira 0,30 

Pedro Silva 0,55 

Maria Alves 0,41 
 

4.5.3 SMART 

O método SMART (Edwards & Barron, 1994) é uma técnica simples e rápida de atribuir valores às 

alternativas. Primeiro, o analista atribui 10 pontos à(s) alternativa(s) que considera pior(es). Depois irá 

atribuir pontos às restantes alternativas com base na alternativa pior. 

 

Utilizando o critério “Área de estudos” como exemplo, o avaliador escolhe “Economia” como a pior 

alternativa e atribui 10 pontos. Em comparação, uma “Engenharia” é 3 vezes preferível, e como tal 

atribui 30 pontos, e a área de “Informática” é 4 vezes preferível, e atribui 40 pontos. Ficamos então 

com as seguintes pontuações: 
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Tabela 4.6 - Exemplo de atribuição de pontos SMART 

Candidato Área de estudos Pontos 

João Ferreira Informática 40 

Pedro Silva Economia 10 

Maria Alves Eng. Eletrónica 30 
 

As pontuações de cada alternativa serão calculados pela seguinte fórmula: 

ሺ�ሻ ݋çãܽݑݐ݊݋�  = ∑ሺ�ሻݏ݋ݐ݊݋� ሺ݅ሻ௜ݏ݋ݐ݊݋�  

 

A tabela seguinte mostra então as pontuações para cada uma das alternativas no critério “Área de 

Estudos”. 

Tabela 4.7 - Pontuações atribuídas às alternativas no critério Área de Estudo 

Candidato Pontuação 

João Ferreira 0,5 

Pedro Silva 0,125 

Maria Alves 0,375 
 

4.5.4 AHP 

No método AHP a atribuição dos pesos aos critérios ou alternativas é feita através da construção de 

uma matriz com as comparações par a par entre alternativas para um determinado critério, ou entre 

critérios para uma determinada categoria ou objetivo global. Nesta subsecção apenas será abordada a 

construção desta matriz e o cálculo dos pesos através da matriz; o cálculo do peso global de cada 

alternativa será remetido para a subsecção seguinte. 

 

O preenchimento da matriz deverá ser feito comparando cada alternativa ou critério aos pares. A 

comparação entre cada par de elementos irá resultar num valor respeitando as regras da seguinte 

tabela. 
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Tabela 4.8 - Valores de preferências em matrizes AHP ((Tereso, 2009) , adaptado de Saaty (1980)). 

 

Os números 2, 4, 6, 8, também podem ser usados para exprimir compromissos intermédios. No caso 

de comparações inversas, isto é, y ser mais importante que x, serão utilizados os valores inversos aos 

da tabela. Por exemplo, caso y seja muito mais importante que x, o valor a utilizar será 1/5. 

 

Tomando como exemplo o objetivo global de escolher o Melhor Candidato, o avaliador determinou que 

a “Área de estudos” é ligeiramente mais importante que a “Média” e muitíssimo mais importante que 

a “Disponibilidade Imediata”, e que a “Média” é muito mais importante que a “Disponibilidade 

Imediata”. A matriz ficará então preenchida da seguinte forma: 

Tabela 4.9 - Matriz de preferências AHP da categoria Melhor Candidato 

  Média Área Disponibilidade 

Média 1  1/3 5 

Área 3 1 7 

Disponibilidade  1/5  1/7 1 
 

 

Para calcular os pesos de cada critério, é utilizada uma aproximação ao vetor próprio com maior valor 

próprio. Em primeiro lugar são normalizadas as colunas, isto é, cada elemento é dividido pela soma da 

coluna. Neste exemplo, obtém-se a seguinte matriz. 

 

Tabela 4.10 - Matriz de preferências AHP com colunas normalizadas 

  Média Área Disponibilidade 

Média 0,24 0,23 0,38 

Área 0,71 0,68 0,54 

Disponibilidade 0,05 0,10 0,08 
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Para obter os pesos, são somadas as linhas da matriz e divididas pelo número de elementos 

diferentes. Ficamos então com os pesos finais para a categoria “Melhor candidato”. 

 

 
Tabela 4.11 - Pesos atribuídos à categoria Melhor Candidato 

Critério Peso 

Média 0,283 

Área 0,643 

Disponibilidade 0,074 

 

Além dos pesos de cada critério, para cada matriz AHP é também calculada uma taxa de consistência 

(TC). Esta taxa indicará a consistência das comparações efetuadas e deverá ser inferior a 0,10 (Saaty, 

1980).  

 

Em primeiro lugar será feita uma aproximação a λmax (maior valor próprio da matriz). Em primeiro 

lugar multiplicamos a matriz de comparações (Tabela 4.9) pelo vetor de pesos obtidos (Tabela 4.11), 

para obter um novo vetor.  

 

[ ͳ ͳ/͵ ͷ͵ ͳ ͹ͳ/ͷ ͳ/͹ ͳ] × [Ͳ.ʹͺ͵Ͳ.͸Ͷ͵Ͳ.Ͳ͹Ͷ] =  [Ͳ.ͺ͹ʹ.ͲͳͲ.ʹʹ] 

 

Os elementos deste novo vetor serão divididos pelos elementos do vetor de pesos, e a sua soma 

dividida pelo número de elementos resultará em λmax. 

 

�max = ቀͲ.ͺ͹Ͳ.ʹͺ +  ʹ.ͲͳͲ.͸Ͷ +  Ͳ.ʹʹͲ.Ͳ͹ቁ͵ =  ͵.Ͳ͹ 

 

De seguida calcula-se o índice de consistência. 

ܥܫ  =  � max − ܰܰ − ͳ =  ͵.Ͳ͹ − ͵͵ − ͳ = Ͳ.Ͳ͵ 

 



42 

 

O último valor necessário é o índice aleatório (IA), que se pode obter na Tabela 4.12, calculada em 

(Saaty, 1980) por simulação. 

 

Tabela 4.12 - Tabela de índices aleatórios ((Tereso, 2009), adaptado de Saaty (1980)) 

 

 

Podemos então calcular a taxa de consistência da matriz. Como temos um valor inferior a 0.1, esta 

matriz é consistente. 

ܥܶ  = �ܫܥܫ  = Ͳ.Ͳ͵Ͳ.ͷͺ = Ͳ.Ͳ͸ 

4.5.5 Cálculos globais 

Depois de calculados os pesos em todos os níveis da hierarquia, passa-se ao cálculo do peso global 

das alternativas. No entanto, é necessário verificar primeiro se os pesos obtidos pelas alternativas nos 

vários critérios são comparáveis. Como vimos nas secções anteriores, os Pesos Diretos e as Funções 

de Valor atribuem um peso relativamente ao valor ideal de 1, enquanto os métodos AHP e SMART 

atribuem os pesos normalizados, com a soma destes a ser igual a 1. Para garantir a compatibilidade, o 

programa transforma todos os pesos em valores normalizados (método AHP) ou em percentagens do 

ideal (método Aditivo), consoante a opção escolhida pelo utilizador. 

 

Caso a opção escolhida seja o método aditivo, os pesos obtidos através dos métodos AHP e SMART 

são convertidos para percentagens do total. A conversão utilizada é a mesma que em (Mustajoki & 

Hamalainen, 2000) e inicialmente sugerida em (Dyer, 1990), e consiste em atribuir o valor 1 à 

alternativa com maior pontuação, e atribuir as restantes pontuações relativamente ao valor da melhor. 

Na Tabela 4.13 encontramos o exemplo da conversão dos pesos do critério “Área de estudos” obtidos 

na subsecção anterior. 

 

 

 



43 

 

Tabela 4.13 - Conversão de pesos para percentagem do ideal 

Candidato Pontuação Pontuação (convertida) 

João Ferreira 0,5 1,00 

Pedro Silva 0,125 0,25 

Maria Alves 0,375 0,75 
 

 

Se a opção for o método AHP, será feita a normalização dos pesos obtidos através de Pesos Diretos e 

Funções de Valor. A Tabela 4.14 mostra a conversão dos pesos dos critérios “Média” e 

“Disponibilidade Imediata”. 

 
Tabela 4.14 - Normalização de pesos 

  
Média 

Média 
(normalizada) 

Disponibilidade 
Disponibilidade 
(normalizada) 

João Ferreira 0,30 0,24 0,75 0,27 

Pedro Silva 0,55 0,44 1 0,36 

Maria Alves 0,41 0,32 1 0,36 

 

No restante desta subsecção serão usados os valores normalizados da Tabela 4.14. Em cada categoria 

da hierarquia temos então as pontuações de cada alternativa em relação aos nós inferiores, e os pesos 

de cada um desses nós inferiores na categoria atual (Tabela 4.15). Serão então calculados os pesos de 

cada alternativa para a categoria atual, e o processo será repetido para todas as outras categorias, 

começando sempre pela que estiver mais baixo na hierarquia e ainda não tiver sido calculada. 

 

Tabela 4.15 - Valores pré-calculo na categoria Melhor Candidato 

  Média Área Disponibilidade 

João Ferreira 0,24 0,50 0,27 

Pedro Silva 0,44 0,125 0,36 

Maria Alves 0,32 0,375 0,36 

        

Peso Critério 0,283 0,643 0,074 
 

 

Para demonstrar os cálculos efetuados em cada nó, vamos tomar como exemplo a categoria “Melhor 

Candidato”. A Tabela 4.15 resume todos os valores disponíveis para essa categoria. O método de 
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cálculo dos pesos das alternativas é igual ao AHP, ou seja, soma-se o produto da pontuação em cada 

critério pelo peso desse critério. 

ሻܽݎ݅݁ݎݎ݁� ݋ã݋ܬሺ ݈ܽ݊݅� ݋çãܽݑݐ݊݋�  = Ͳ.ʹͶ × Ͳ.ʹͺ + Ͳ.ͷ × Ͳ.͸Ͷ + Ͳ.ʹ͹ ∗ Ͳ.Ͳ͹ = Ͳ.Ͷͳ �ܽݑݐ݊݋çã݋ �݈݅݊ܽ ሺ�݁݀ܽݒ݈݅ܵ ݋ݎሻ = Ͳ.ͶͶ × Ͳ.ʹͺ + Ͳ.ͳʹͷ × Ͳ.͸Ͷ + Ͳ.͵͸ ∗ Ͳ.Ͳ͹ = Ͳ.ʹ͵ �ܽݑݐ݊݋çã݋ �݈݅݊ܽ ሺݏ݁ݒ݈� ܽ݅ݎܽܯሻ = Ͳ.͵ʹ × Ͳ.ʹͺ + Ͳ.͵͹ͷ × Ͳ.͸Ͷ + Ͳ.͵͸ ∗ Ͳ.Ͳ͹ = Ͳ.͵͸ 

A Tabela 4.16 mostra as pontuações finais para a categoria “Melhor Candidato”, que neste exemplo 

simples se trata do objetivo global. O candidato preferido seria então o “João Ferreira”. 

 

Tabela 4.16 - Pontuações finais de cada alternativa na categoria Melhor Candidato 

Candidato Pontuação Final 

João Ferreira 0,41 

Pedro Silva 0,23 

Maria Alves 0,36 
 

4.5.6 Análise de sensibilidade 

Para além do cálculo das pontuações globais das alternativas, o software permite também fazer uma 

análise de sensibilidade. Em cada categoria, é possível escolher uma das subcategorias ou critérios e 

alterar o seu peso de forma a visualizar quais seriam as alterações no resultado final. 

 

Para efetuar estes cálculos, é necessário primeiro recalcular os pesos de cada subcategoria ou critério 

na categoria escolhida. Assumindo que a categoria tem N subcategorias ou critérios, e cada critério i 

tem um peso pi. Se alterarmos o peso de um critério j para pj’, os pesos serão calculados da seguinte 

forma: 

 

ሺ݅ሻ݌ = { ,′݆݌ ݅ = × ݅݌݆ ቆͳ + ݆݌ − ∑′݆݌ ௞∈�,௞≠௝݇݌ ቇ , ݅ ≠ ݆ 

 

Voltando ao exemplo (ver Tabela 4.11), se na categoria “Melhor Candidato” alterássemos o peso do 

critério “Disponibilidade” para 0.5, os pesos seriam alterados da seguinte forma: 
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é݀݅ܽሻܯሺ ݋ݏ݁� = Ͳ.ʹͺ͵ ×  (ͳ + Ͳ.Ͳ͹Ͷ − Ͳ.ͷͲ.ʹͺ͵ +  Ͳ.͸Ͷ͵) = Ͳ.ͳͷ 

(ܽ݁ݎÁ) ݋ݏ݁� = Ͳ.͸Ͷ͵ ×  (ͳ + Ͳ.Ͳ͹Ͷ − Ͳ.ͷͲ.ʹͺ͵ +  Ͳ.͸Ͷ͵) = Ͳ.͵ͷ �݁݋ݏ ሺ݈ܾ݁݀ܽ݀݅݅݅݊݋݌ݏ݅ܦሻ = Ͳ.ͷ 

 

Ficamos então com os seguintes pesos: 

 

Tabela 4.17 - Pesos na categoria Melhor Candidato 

Critério Peso 

Média 0,15 

Área 0,35 

Disponibilidade 0,50 
 

 

Para calcular o novo resultado final, são efetuados os cálculos apresentados na subsecção 4.5.5, com 

a substituição prévia dos pesos na categoria “Melhor Candidato” por aqueles da Tabela 4.17. O 

resultado final, será o seguinte: 

 

Tabela 4.18 - Pontuações globais de cada alternativa após alteração do peso de um dos critérios 

Candidato Pontuação (nova) Pontuação (antiga) 

João Ferreira 0,35 0,41 

Pedro Silva 0,29 0,23 

Maria Alves 0,36 0,36 
 

 

Com esta alteração, a melhor candidata passou a ser a Maria Alves, apesar da sua pontuação não 

sofrer alterações. 
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5. UTILIZAÇÃO DO SOFTWARE 

Neste capítulo será demonstrada a utilização do software, recorrendo ao exemplo do capítulo anterior. 

5.1 Instalação 

A instalação do software é feita através do executável com o nome SetupBeSmart2 que pode ser obtido 

em http://code.google.com/p/besmart2/. O processo de instalação é bastante simples, não sendo 

requerido ao utilizador nenhuma informação extra. 

 

 

Figura 5.1 - Menu de instalação da ferramenta BeSmart2 

 

Após a instalação será criado um atalho no Ambiente de Trabalho do utilizador que poderá ser utilizado 

para abrir a ferramenta. A ferramenta está construída para correr em ambiente Windows. 

http://code.google.com/p/besmart2/
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Figura 5.2 - Ícone do BeSmart2 

5.2 Novo modelo 

Ao abrir o programa, o menu inicial encontra-se vazio. Nesta interface inicial será mostrada a 

hierarquia de categorias e critérios bem como a lista de alternativas, assim que um novo modelo seja 

criado. 

 

 

Figura 5.3 - Menu inicial do software antes da criação do modelo 

 

Vamos então demonstrar como criar o modelo para escolha do Melhor Candidato, tal como descrito no 

capítulo anterior. Em primeiro lugar, deve-se ir a “File -> New”, e preencher o objetivo principal do 

modelo, que neste caso será obter o “Melhor Candidato”. 

 



49 

 

 

Figura 5.4 - Janela para inserir o objetivo principal 

 

Nas subsecções seguintes serão criadas as categorias, critérios e alternativas do modelo. 

5.2.1 Categorias 

Neste modelo não serão criadas mais categorias para além do objetivo principal. Caso se desejasse 

adicionar uma nova categoria, seria possível através do menu “Model -> Add -> Category” ou clicar 

com o botão direito do rato na categoria “Pai” e escolher “Add -> Category”. Qualquer das opções iria 

abrir o menu da Figura 5.5 onde se pode introduzir o nome da categoria. 

 

 

Figura 5.5 - Menu de adicionar nova categoria 

 

Para modificar ou remover uma categoria, deve-se clicar com o botão direito do rato na categoria a 

modificar/remover e escolher “Modify” ou “Remove”, respetivamente. Em alternativa, pode-se abrir o 

menu da Figura 5.6 que se encontra em “Model -> Edit -> Categories and Criteria”. 
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Figura 5.6 - Menu de modificar e remover critérios e categorias 

 

Ao remover uma categoria serão também removidas todas subcategorias e critérios que pertençam a 

essa mesma categoria. 

5.2.2 Critérios 

Para adicionar um critério novo, tal como nas categorias, podemos ir ao menu “Model -> Add -> 

Criterion” ou em alternativa clicar com o botão do rato na categoria “Pai” e escolher “Add -> Criterion”. 

 

Figura 5.7 - Criação de um novo critério com escala numérica 
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No menu de novo critério é necessário inserir o nome do critério, escolher a categoria “Pai” e o tipo de 

escala: numérica, discreta ou binária. No caso duma escala numérica, como na Figura 5.7, é 

necessário inserir a unidade de medida, os valores mínimos e máximos da escala (opcionais), e indicar 

se o objetivo será minimizar ou maximizar o valor. 

 

 

Figura 5.8 - Criação dum novo critério com escala discreta 

 

Caso se trate duma escala discreta, é necessário adicionar pelo menos dois valores à escala (através 

do botão “+”). O botão com o símbolo “-“ serve para remover o valor selecionado, e as setas movem o 

valor selecionado para cima ou para baixo na escala. De relembrar que o primeiro valor é o melhor da 

escala, e o último corresponde ao pior. 
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Figura 5.9 - Criação de um novo critério com escala binária 

 

Por fim, numa escala binária não é necessário inserir nenhuma informação adicional. Ao adicionar um 

novo critério, caso já existam alternativas no modelo, irá aparecer a janela da Figura 5.10, que permite 

abrir diretamente o menu de alternativas (Figura 5.11) e inserir os valores para o novo critério. 

 

 

Figura 5.10 - Menu que permite a inserção de valores para novos critérios 

 

Para modificar ou remover um critério, o processo é muito semelhante aquele das categorias: através 

do menu “Model -> Edit -> Categories and Criteria” ou clicando com o botão direito do rato no critério 

na hierarquia. 
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5.2.3 Alternativas 

Após criação de toda a hierarquia de categorias e critérios, podemos passar a inserção das alternativas 

e dos seus valores. Este processo é todo feito no menu da Figura 5.11 que pode ser acedido através 

de “Model -> Edit -> Alternatives” ou clicando com o botão direito do rato na tabela de alternativas e 

escolher “Edit”. 

 

 

Figura 5.11 - Menu de edição das alternativas 

 

Para cada linha, deverá ser preenchida a coluna “Name”, bem como os valores para todos os critérios. 

O preenchimento da coluna “Link” é opcional, dependendo se existe ou se é útil incluir uma página 

Web relativa à alternativa. O botão “Add Alternative” adiciona uma nova linha à tabela, e o botão 

“Remove Alternative” remove a linha selecionada. Para assegurar que as alterações ficam guardadas, 

deve sair do menu através do botão “Confirm Changes”. 
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Figura 5.12 - Menu principal após criação do modelo 

 

Após criação de todo o modelo, o menu principal fica com o aspeto da Figura 5.12, incluindo a 

hierarquia de categorias e critérios, bem como a lista de alternativas. Ao clicar no link de uma 

alternativa será aberta a página no browser pré-definido. Pode alterar a vista para mostrar os valores 

em vez dos links (Figura 5.13). 

 

 

Figura 5.13 - Tabela de alternativas no menu principal com vista de valores 

 

 

 

 



55 

 

5.3 Gravação e leitura do modelo 

Para gravar permanente o modelo criado, o utilizador deve utilizar o menu “File -> Save”, que irá 

gravar o modelo no ficheiro atual, ou irá pedir ao utilizador o nome e localização do ficheiro caso se 

trate de um novo modelo. A opção “File –> Save As” permite ao utilizador escolher o nome e a 

localização independentemente de se tratar de um novo modelo ou não. Para o carregamento de um 

modelo guardado anteriormente deve ser escolhida a opção “File -> Open” e navegar até à pasta onde 

foi gravado o modelo (caso não tenha sido gravado na pasta pré-definida). 

5.4 Nova comparação 

Depois de criado o modelo, podemos passar à parte da comparação e dos cálculos. Para começar 

uma nova comparação encontramos o botão “Start Comparison” no menu principal, ou o menu 

“Comparison -> Start New”. 

 

A opção “Comparison -> Open” permite abrir uma comparação guardada anteriormente. Caso a 

comparação aberta tenha sido feita com um modelo diferente, uma mensagem de erro será 

apresentada. 

5.4.1 Escolha das alternativas 

Ao começar uma nova comparação, terão de ser escolhidas quais as alternativas a incluir na 

comparação. Terá de ser selecionado um mínimo de 2 alternativas. 
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Figura 5.14 - Janela de escolha de alternativas para comparação 

 

5.4.2 Menu comparação 

Após a escolha das alternativas, irá aparecer o menu da Figura 5.15. No canto superior esquerdo, 

podemos escolher qual o método de cálculo global (secção 4.5.5). Por baixo, temos a lista dos vários 

critérios e categorias, bem como a indicação do método escolhido para cada um (em branco se 

nenhum for escolhido) e a validade (vermelho se nenhum método for escolhido, ou os valores 

introduzidos forem inválidos ou incompletos, verde se tudo estiver bem). 
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Figura 5.15 - Menu comparação 

 

Do lado superior direito temos o botão para gravação da comparação, e por baixo temos a zona de 

escolha e preenchimento dos vários métodos. Na parte de baixo do menu encontra-se a secção dos 

resultados, que só fica ativa assim que todos os critérios e categorias tiverem métodos escolhidos e 

valores válidos introduzidos. 

5.5 Métodos 

Ao selecionar uma categoria ou critério da lista do lado esquerdo, podemos escolher do lado direito 

qual o método a utilizar. Assim que tiver sido escolhido um método e todos os valores introduzidos 

corretamente, o símbolo passará a verde. Nas categorias não é possível escolher o método funções de 

valor, e como tal este não é selecionável e o nome não aparece. 
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5.5.1 Pesos diretos 

Ao escolher pesos diretos, apenas é necessário preencher a tabela com os pesos de cada alternativa 

ou subcritério. Apenas é permitido inserir valores entre 0 e 1, e os valores são considerados válidos 

quando todos estiverem preenchidos. Caso se trate de uma categoria, é ainda verificado se a soma é 

igual a 1 (aparece por baixo da tabela). Ao lado da tabela encontramos um botão que permite ver os 

valores das alternativas (Figura 5.20), caso se trate de um critério. 

 

 

Figura 5.16 - Inserção de pontuações diretas para um critério 

 

Na Figura 5.16 temos a tabela preenchida com pontuações diretas de acordo com aqueles definidos 

na secção 4.5.1. 

5.5.2 Funções de valor 

As funções de valor apenas estão disponíveis para critérios. Após a escolha deste separador, é 

automaticamente assumido como um método válido, podendo depois ser afinados os limites (máximo 

e mínimo), o fator exponencial e o objetivo (minimizar ou maximizar). 
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Figura 5.17 - Definição de parâmetros de uma função de valores 

 

A figura anterior mostra a função de valores para o critério “Média” tal como definido na secção 4.5.2. 

5.5.3 AHP 

A seleção de células e inserção de pesos na matriz AHP pode ser feita de duas formas distintas. Para 

selecionar a célula, esta pode ser clicada diretamente na tabela, ou alternativamente selecionadas as 

alternativas ou critérios a comparar nas duas caixas que aparecem no topo. Para inserir o valor, este 

pode ser introduzido diretamente (só aceita valores entre 0 e 9), ou então através da barra deslizante 

no topo. Ao introduzir um valor, o valor simétrico é automaticamente preenchido. Não é possível alterar 

os valores da diagonal, pois estes deverão ter sempre o valor de 1. 
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Figura 5.18 - Inserção de pesos AHP para uma categoria. 

 

Após preencher a matriz, os pesos irão aparecer na tabela do lado direito, e o índice de consistência da 

matriz irá aparecer por baixo da tabela. 

5.5.4 SMART 

No método SMART, os valores deverão ser introduzidos na tabela da esquerda. A tabela só aceita 

valores iguais ou superiores a 10, e só considera um resultado válido quando todos os valores forem 

preenchidos e pelo menos um dos valores for igual a 10. Os pesos serão então apresentados na tabela 

da direita. 

 

 

Figura 5.19 - Inserção de pesos SMART para um critério 
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Tal como nos métodos Pesos Diretos e AHP, temos um botão que permite abrir uma janela com os 

pesos das alternativas (caso se trate de um critério), que podemos ver na figura seguinte. 

 

 

Figura 5.20 - Janela com os valores das alternativas 

5.6 Resultados 

Após todas as categorias e critérios terem pesos válidos, são apresentados os resultados na parte 

inferior do menu de comparação. A área de resultados é dividida em 3 vistas diferentes: vista geral, 

vista detalhada e análise de sensibilidade. 

5.6.1 Vista geral 

Na vista geral encontramos os pesos globais de cada alternativa, calculados de acordo com o método 

escolhido (AHP ou aditivo). Do lado esquerdo encontramos os valores em forma de tabela, e do lado 

direito a sua representação em gráfico de barras. 
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Figura 5.21 - Vista geral dos resultados 

 

A opção “Show criteria scores?” permite dividir as barras no gráfico pela contribuição dos vários 

critérios, atribuindo a cada critério uma cor diferente e mostrando na legenda o peso de cada um 

deles. 

 

 

Figura 5.22 - Vista geral dos resultados dividida por critérios 
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5.6.2 Vista detalhada 

Na vista detalhada, podemos encontrar uma vista semelhante à vista geral, mas podemos escolher 

qual o nó da hierarquia. Por exemplo, podemos ver qual foi a peso de cada alternativa no critério 

“Média”. 

 

 

Figura 5.23 - Vista detalhada de resultados de um critério 

 

Caso se se tratasse de uma categoria, o gráfico mostraria a divisão pelos vários subcritérios dessa 

subcategoria. Como neste modelo apenas temos uma categoria que é o objetivo principal, este gráfico 

será igual ao da vista geral. 

 

 

Figura 5.24 - Vista detalhada de resultados de uma categoria 
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5.6.3 Análise de sensibilidade 

Por fim, na vista de análise de sensibilidade podemos escolher uma categoria e alterar o valor do peso 

de um dos seus subcritérios e ver o resultado final de acordo com essa alteração.  

 

 

Figura 5.25 - Vista de análise de sensibilidade 

 

Na tabela da esquerda encontramos o peso global das alternativas com a alteração no peso do critério 

“Disponibilidade”. No gráfico, encontramos a variação do peso de cada alternativa ao longo de todos os 

valores possíveis do peso desse critério. 

 

A análise de sensibilidade permite ao utilizador verificar quais seriam as alterações no resultado final 

caso as suas preferências variassem, sem ter que reintroduzir todos os valores e refazer todos os 

cálculos.
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6. CONCLUSÕES E TRABALHO FUTURO 

6.1 Conclusões 

Quando estamos perante uma decisão com várias alternativas, como decidir entre elas? Quando umas 

são melhores nalgumas características mas piores noutras, como podemos objetivamente dizer qual 

delas é a melhor? O processo de tomada de decisão é um assunto vasto e difícil, e podem existir vários 

tipos de decisões e maneiras diferentes de lidar com elas. 

A teoria da decisão veio trazer alguma clarificação e estruturação no que toca a estes problemas de 

decisão. Através da definição de termos e conceitos concretos, é possível definir claramente quem está 

a decidir, sobre o que recai a decisão, quais são as possíveis escolhas e quais são as consequências 

de cada uma dessas escolhas. 

Pode-se dizer que cada decisão é única, mesmo em situações em que as escolhas possíveis são as 

mesmas, o julgamento de valor de diferentes decisores pode resultar em avaliações completamente 

distintas das várias consequências: a escolha ótima é então subjetiva e depende de quem está a 

decidir. 

Com a análise de decisão multicritério apareceram variados métodos e modelos que permitem a 

resolução deste tipo de problemas. Cabe ao agente de decisão escolher qual o método que mais se 

adequa ao problema em questão, e garantir que as preferências e julgamentos de valor de todos os 

atores e demais envolvidos na decisão são tomados em conta. 

Nem sempre este é um processo trivial, por vezes pela falta de acesso simples a estes métodos, por 

outras pela complexidade dos problemas que impedem a sua fácil utilização. A criação de ferramentas 

informáticas para este efeito veio ajudar a resolver este tipo de limitações e alargar o espectro de 

utilizadores potenciais de métodos de decisão multicritério. 

Com este trabalho, foi feito um estudo aprofundado dos aspetos mais importantes nestas áreas de 

decisão e análise multicritério, nomeadamente o que é a teoria de decisão, para que serve, quais são 

os principais problemas que ajuda a resolver, e quais são e como se podem classificar os principais 

métodos de ADM. Foi depois desenvolvida uma ferramenta, com base numa ferramenta existente, 

melhorando a sua interface com o utilizador e introduzindo novos métodos de cálculo.  

Em termos de interface, a nova ferramenta permite a visualização da árvore de objetivos, uma edição 

de objetivos e alternativas mais intuitiva, permite um número ilimitado de alternativas numa 

comparação, uma forma de preenchimento de valores mais simples, que permite ao utilizador escolher 
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qual o objetivo por onde começar, e mais facilmente identificar o método utilizado em cada um, a 

possibilidade de guardar resultados intermédios ou completos para utilização futura, e ainda uma 

visualização gráfica de resultados mais completa, com possibilidade de fazer uma análise de 

sensibilidade. Em termos de métodos, foi tornada mais flexível a escolha dos mesmos (permite a 

utilização dos métodos SMART e pesos diretos para todos os tipos de objetivos), permite escolher 

como serão feitos os cálculos globais, e a modularidade do código permitirá a introdução de novos 

métodos sem grandes alterações ao código base do software. 

Esta ferramenta, que está disponível online em http://code.google.com/p/besmart2, permite a um 

utilizador sem grandes conhecimentos de teoria de decisão resolver problemas de decisão multicritério, 

com uma interface intuitiva, com recurso aos métodos AHP, SMART e Funções de Valor. 

Espera-se também que a contribuição dada através da ferramenta criada, venha a resultar numa mais-

valia, na obtenção de melhores decisões, para os agentes de decisão (empresas e pessoas individuais) 

que a venham a utilizar. 

6.2 Trabalho Futuro 

Este trabalho está longe de ser um ponto final na análise das técnicas de análise multicritério, e 

principalmente nas ferramentas de software de decisão multicritério. São constantemente 

apresentados novos métodos e ferramentas que podem revolucionar a forma como é vista a tomada de 

decisão em ambientes com múltiplos critérios. Assim, a revisão apresentada neste relatório deve 

apenas ser vista como um ponto de partida para uma atualização que terá de ser constante. Apenas 

servirá como um resumo do estado da arte atual, que poderá ser obsoleto dentro de uns anos. 

Quando à ferramenta desenvolvida, ainda existem muitas possibilidades de melhoria. Em termos 

gráficos seria possível incorporar um assistente de utilização que funcionasse como um guia para o 

utilizador comum. Também seria uma adição interessante a criação dum sistema de relatórios 

detalhados, que permitisse analisar os resultados quer no ecrã quer em papel. Por fim, a introdução de 

métodos adicionais, como aqueles referidos na literatura do parágrafo anterior, faria a plataforma ainda 

mais completa.  
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